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INTRODUCTION

Over the years the State and County have been putting down concrete, steel and other material to form artificial
reefs where fish can gather and populate. However, for many years the location of the deployment was recorded
using Loran and GPS system where the accuracy was intentionally being decreased for national security. In
addition, the tug boat, barge and crane offset distances contributed to the inaccuracies. When a deployment was
made, the correct location typically was inaccurately recorded. In an effort to eliminate the wasted time and gas
driving around looking for dive and fishing sites, we developed a method to visualize the bottom and provide an
extremely accurate and detailed map of the bottom structures.

About Contour Charts

The contour maps we produce are a birds-eye (overhead, looking directly down) view of ocean topography (bottom
contours or bathymetry). Typically, the closer the contour lines are the sharper the increase or decrease in depth
which may indicate a wreck, ledge or reef which attract fish and the greater likelihood you will catch one. Scuba
divers will love the ability to see the height and position of the structures and drop anchor, right “down the hatch”.
Fisherman will love putting the hook right on the structure and “in the fish’s mouth”. The places to fish and dive are
obvious on the charts and extremely accurate.

How the Data Was Collected

Three boats were used for the past 18 years in the collection of hundreds of thousands of sonar data points with the
corresponding WAAS GPS Latitude and Longitude from each reef. All contour charts are created from sonar data
while slowly “trolling” in a “mowing the lawn” pattern directly over each reef or wreck. For example, more than
25,000 samples were collected for just one area reef. Official county waypoints were used as a starting point and
the entire area was scanned. When structures were detected, additional close-in scanning was performed to
enhance detail.

How the Plots Were Created

The collected position and depth data is then adjusted for tides, interpolated to fill in uncollected data and analyzed
to visualize the bottom. Official county waypoints were overlaid on the plot and the reef deployment data was
correlated to nearest detected targets. In some cases, the sites were confirmed by an underwater camera or by
scuba diving the site.

How To Use These GPX Files

After the entire area was plotted, we picked a select number of high-profile sites and assigned them as a waypoint.
These waypoints were assembled into a GPX file which can be loaded into most GPS units, laptop software and
tablets. Please refer to the GPS user manual on how to accomplish this as it varies by manufacture. Some have
SD card that you load and insert. Some require you to connect the GPS to a computer to download the files.
Whatever the method, you would then select “GO TO” on the GPS, scroll to the desired waypoint and press Enter
(or equivalent on your GPS). Most GPS units will show the distance and bearing to the waypoint with a line to follow
to get there.

NOTE: All views on these charts should not be used for navigation.

Contacts

For additional information contact CSS Inc. at 941-739-8394 and please leave a message as | am usually out
scanning new reefs and wrecks. Even better is to E-Mail us at Bob@reefsnwrecks.com and we will promptly return
your Email. Checkout our free reef offers for the Alan Fisher reef later in this manual.

All rights reserved. Reproduction of any part of this work beyond that permitted by Section 107 of the 1976
United States Copyright Act is unlawful.
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About the GPX Format

The data in the GPX files are intended to be downloaded into your handheld or helm mounted GPS unit and also
into your PC for use with OpenCPN and into your mobile device for use with SealQ. Each file contains a number of
high profile waypoints which includes the Latitude and Longitude along with a description of the reef, its depth and

relief along with the date of deployment. The reef description also contains the distance and heading from at least
one inlet or reference point.

After downloading you will need to load the file into your GPS/device. To do this | would recommend getting the
user manual for your GPS and look for the section “Loading a GPX File”.

You will also need a PC to download the custom contour maps from our website, unzip the files and
download the files to a SD or MicroSD card.

Determine what size SD card your GPS unit requires, SD or MicroSD. An 8GB to 16GB Micro SD should be
more than enough room for dozens of maps. If you need a micro SD card, make sure you purchase the
Micro SD adaptor for the MicroSD card. Many times, they are sold together.

Kingston

Y Lock

micre | P

ass

M

ADAPTER == e

8

MicroSD Card and Adapter

Your computer will also need to have a drive for SD cards. If oneis not built in, you will need to purchase
one at your local store.

External SD Card Reader
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About other Formats

We have other file formats that provide a visual picture of the bottom contours and can be purchased for a few
dollars more. All formats include this GPX file.

We are working hard to produce other formats for other devices. Please contact us if you need support for
Raymarine. Check back often to the website as we will be adding additional formats as they are developed.

All the different formats will allow you to find the exact position for a perfect day of fishing or diving.

About the Areas

We are also working hard to expand our coverage area. We have scanned over 200 sites around Florida and have
started to expand further north and south. Check back often to the website, as we will be adding additional reefs
and wrecks on a weekly basis.

Contributions
If you have a boat, good quality GPS/Depth sounder and are interested in joining our data collection team, please

contact us at Bob@ReefsnWrecks.com. If you have a favorite area that you would like scanned, let us know and
you will receive the completed scan in the format of your choice for free and a promise to limit the sale of that site.

Copyright © 2022 CSS Inc. 4
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Reefsnwrecks Website

Below is a screen shot from the ReefsnWrecks home page. It has a series of tabs along the top row listing the

Florida counties we have made custom contour charts for. In the following examples | have chosen the SARASOTA
tab (yellow highlighted)

WELCOME TO REEFSNWRECKS.COM

ReefNWrecks.com & ACCOUNT T CART

Search entire store here 0\

MANATEE SARASOTA PINELLES HILLSBOUGH LEE CHARLOTTE MONROE DADE

When that screen comes up, you will see an overall map of the area showing the name and location of all the reefs,
ledges and wrecks that we have available for you to purchase and download to your system for immediate use.

Sarasota
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Scroll down the page and view the various reefs we have available. Selecting the left box in the Shopping Options

section at the top of the page just under the county map. This view of the page gives you a little more detail and a
description.

Shopping Options mE || = [ temz13Dofs3 SortBy | ProductMame ~ | 4
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For example, if you selected Sarasota, Fisher Reef, you will see the following screen:

Fishier Reef
s0.08

POl - O

$ g v FREE! This is an artificial reef consists of concrete rubble, baxes and piles from the old Mew Pass bridge and put down starting in 1980. This site is
close to shore at 2.8 miles @226 degrees miles from Mew Pass. The water depths here is inthe 31 foot range. Learn More

FREE

If you left mouse click on the reef chart or the reef name it will take you to the format selection and Add to cart
page.

Fisher Reef

$0.08 st

nd piles fi the oid \

FREE

ot
{

hJ
o
AN |
B
i
=

h
Ny

Fizher Rsef « Add to Cart

@ DD TO WISH LIST I8 ADD TO COMPARE

sample

On middle left of the screen, you will see 3 thumbnail views. For each reef or wreck we have provided three views,
a sample of the actual reef contour map, a close-up of the location on the NOAA chart showing the red custom
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contour reef map coverage and a third view zoomed out so you can get a better idea where the reef or wreck is
located.

-
R
# 1
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On the right side you will see a description of the reef or wreck, the distance off shore and bearing from the nearest
inlet or landmark. On the bottom there is a list of file formats that you can select to purchase. You can select one
or all depending on your needs and equipment.

If you select SAMPLE you will be able to download a copy of that format’s user manual which has details on
ordering, installing and using the selected format.

The GPX format is a file containing the latitude and longitude of points of interest for that reef. It includes all
material drops made on an artificial reef, the center of a wreck or a few points along a ledge or drop-off. Itis
included in all the formats or is available by itself at the base price.

When you select other formats, it adds the additional cost indicated to the base price. For example, ordering the
PDF format in the example above will cost $2.99 (GPX) + $1.99 (PDF) = $4.98. Adding the KAP format to the
order will cost $4.98 + $1.99 or $6.97. The total price will be shown in the upper right corner.

Copyright © 2022 CSS Inc. 7



SKY\WAY BRIDGE REEF $6.97
IN STOCK

This site is directly south west of the old Sunshine Bridge approaches. The onginal
two-lane brnidge was completed in 1954, The main span of the northbound bridge
was demolished in 1932 and the approaches for both old spans were made into
the Skyway Fishing Pier State Park. It consists of concrete rubble lined up in rows
put down in 1992, The water depths here are in the 12 - 22 foot range.

The KAP format contains the GPX file along with the custom contour chart for use on a PC using a full nautical
navigation program named OpenCPN or on a smart phone or tablet like an iPad using a full nautical navigation app
called SealQ.

The QDC format contains the GPX file along with the custom contour chart for use on a Garmin Depth sounder or
Chartplotter compatible with Quickdraw Contours. (Please check your Garmin unit for compatibility with Quickdraw
contours on the Garmin website.) If you have a Garmin Handheld GPS chose the KMZ format.

The PDF format contains the GPX file above with a PDF file containing pages of contour maps that can be
printed out and brought with you. It contains a list of the various waypoints, their deploy dates and a brief
description of the reef along with an overall view and individual zoomed in views of the reef or wreck. Each
view contains a grid so you can determine the GPS location of any interesting point.

The KMZ format contains the GPX file along with the custom contour chart in viewable format on Google Earth or on
a Garmin Handheld GPS unit. (Please check your Garmin hand held GPS compatibility for Custom Maps on the
Garmin website.

The ATS5 format contains the GPX file along with the custom contour chart in viewable format directly on a
Lowrance, Simrad or B&G chartplotter. (Please check your Lowrance, Simrad or B&G chartplotter compatibility for
Custom Charts on the Lowrance, Simrad or B&G website.

| suggest you download the almost FREE Sarasota, Fisher Reef first and try it out on your unit.

Also, on the right side you will see check boxes for your selection of the format you are purchasing. You can order
one or all of the different formats. Each of the graphic chart formats contain the GPX file.

Once you have selected the format you want, select ADD TO CART. The following screen will be displayed:

SHOPPING CART

} Skyway Bridge Reef was added to your shopping cart.

PRODUCT PRICE aTy SUBTOTAL R
DISCOUNT CODES APPLY
SKYWAY BRIDGE REEF £6.97 1 $6.97
r_ % SKT: hisw
Edit SUBTOTAL %6.97
Dowrload:
Skpway Ericige Res GRAND TOTAL EXCL. TAX $6.97
in KAP Format
Skyway Bridge Reef GRAND TOTAL INCL. TAX $6 . 9 7
in PDF Format
EMPTY CART UPDATE SHOPPING CART -or- CONTINUE SHOPPING
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If Eou want to select additional reef or wrecks select CONTINUE SHOPPING. If you are finished, select [g5{®]ei= =)

If you select Proceed to Checkout you will go to the CHECKOUT screen. As a new customer, select REGISTER to
create an account and complete the requested information. Please be careful when entering your Email address as
all purchases you make will result in an Email to you with a link allowing you to download what you have ordered.
Please use a strong password and record it for future use. We have no access to your passwords and they are
stored in an encrypted format. If you are a returning customer, enter your Email address and Password on the right
and select LOGIN.

CHECKOUT
CHECKOUT METHOCD
REGISTER TO CREATE AN ACCOUNT RETURNING CUSTOMERS

Email Address * * Required Fields
Fast and easy check out

Easy access to yvour order history and status

Password *
REGISTER

Forgot yvour password?

LOGIM

Enter your name, address and Email address in the fields provided. Please be sure your Email address is correct,
as any purchase you make will send a link to that address.

CHECKOUT YOUR CHECKOUT PROGRESS
Edit
BILLING INFORMATION

First Mame * * Required Fields

John

Middle Mame./ Initial
Q

Last Mame =

Public

Company

Email Address *

1QPublic@ABC.COM

Top section of the Register Form

Note: You must complete the ordering process to have your Email address and password registered. If you back
out before ordering and return later, you will have to re-enter your complete ordering information again.

Copyright © 2022 CSS Inc. 9



When compete, press LOGIN or CONTINUE and you will be directed to the CHECKOUT PAYMENT screen.

Select your payment method and select CONTINUE.

CHECKOUT YOUR CHECKOUT PROGRESS
BILLING ADDRESS | CHAMGE
HE T METHOIL Edit John @ Public
55 Main Street
BILLING INFORMAT Edit Amytoum, Florida, 34388
Urmifed States
B 7~ vMENT INFORMATION T: gqr-s55e12
® . What is PayPal?
PayFal

You will be redirected to the PayPal website when you place an order.

O Credit Card {saved)

CONTINUE = Back

B oroER REVIEW

Complete the forms with the requested payment information and press CONTINUE.

CHECKOUT YOUR CHECKOUT PROGRESS

BILLING ADDRESS | CHAMGE
HE T METHOIL Edit Jokn @ Public
55 Main Street
B NG INFORMAT Edit Anytoumn, Florida, 34888
Umited States
- - N Edit T 941-555-1212
i CHANGE
B oroeR ReVIEW PAYMENT METHOD | CHANG
credit Card (saved)
credit card Type:  Mastercard
PRODUCT PRICE QTY SUBTOTAL Credit Cord WNumber: 0005642

Name on the Card:  Johm @ Public
SKYWAY BRIDGE REEF £6.97 1 $6.97

Dowrload:  Skyway Bridge Reef in KAP Format
Skyway Bridge Reef in PDF Format

Subtotal $6.97

Grand Total Excl. Tax $6.97

Grand Total Incl. Tax £6.07

PLACE CRDER Forgot an Itemn? Edit Your Cart

The last step is ORDER REVIEW where you can verify your order, billing address and payment method. When

done, select [IFEA@=0I2B)=RE .

In a few seconds you will receive an Email with a link back to the MY DOWNLOADABLE PRODUCTS screen.
Select the blue “Reef XYZ” Format text (highlighted below) to start the download.

Note: You can download the files a maximum of three times.

Copyright © 2022 CSS Inc. 10



ORDER # DATE TITLE STATUS  REMAINING
DOWNLOADS

100000007  5/3/2016 Cuda Ledge - CUDA LEDGE PDF FORMAT Available 1

You may receive a download message like the one below. This is because the downloaded file is an .exe self-
extracting zip file and for security reasons the operating system needs to ask you if you want to proceed. Select
Run to continue. No software is installed, only files copied to the folder you select.

@ lighthousepdf.exe is not commonly downloaded and could harm
your computer.

Delete Run View downloads <

NOTE: We have set the price of Sarasota, Fisher Reef to $0.08 so you can
download a full reef package in any or all the available formats and try them
out. Just follow all the instructions above to add it to your cart and checkout.
Sorry | have to charge 8¢ because PayPal cannot accept a S0 payment.

NOTE: All downloadable files are self-extracting .exe files and must be run on
a Windows based computer or a computer with Windows compatibility.

They cannot be downloaded directly to an Apple computer or tablet. When
downloading the .exe files, Microsoft will warn you that the files may be
dangerous. Select “Assume the Risk” to override the warning.

When activated, the files will automatically un-Zip the various files and place
them in a folder of your chose. No programs will be run.

Copyright © 2022 CSS Inc. 11



Reefsnwrecks Downloaded File Installation

After you select Run the downloaded file will execute and it will give you directions on what to do and suggests
where to put the files. The process simply unzips a few files and places them in the folder you specify.

Lighthouse Reef PDF

You are about to extract files to your computer.  When asked we
suggest you create and use the directory C:\Reefsnwrecks. Files will be

extracted and placed in the folder. Mo programs will be installed or run
automatically.

Please read and accept the license agreement.

Lighthouse Reef KAP - x

Please read the following license agreement. Press the PAGE DOWN key
to see the rest of the agreement

CSS Incorporated Software Licence

© 2016 C55 Incorporated. All ights reserved. Contour Maps for
viewing depth contours of various reefs and wrecks throughout the
world. Except as permitted by any such license, no part of this guide,
map contour or information files may be reproduced, stored in a
retrieval system, or transmitted. in any form or by any means.
electronic, mechanical, recording, or otherwise, without the prior
written permission of C55 Incomorated. Please note that the content
in this guide is protected under copyright law. The content of this
guide is fumished for informational use only. is subject to change
without natice, and should not be construed as a commitment by CS5
Incorporated. CS5 Incomorated assumes no responsibility or liability
for any emors or inaccuracies that may appear in the informational

v

Do you accept all of the tems of the precading License Agreement? F you
choose No, Install will close. To install you must accept this agreement

Yes No

Browse to where you want to put the files. We recommend a dedicated folder called C:\Reefsnwrecks and a folder
for each county and reef. For example, C:\Reefsnwrecks\Sarasota\Fisher.

Lighthouse Reef KAP - x

Please type the location where you wart to place the extracted files

C:\Users\Robett\Documents\My Documents\Reefsi| [ Browse... |

0K Cancel

When you are complete, you will see this final screen.

Lighthouse Reef PDF

You have just finished extracting the downloaded files to your

o computer. Please go to the folder you chose (e.g. C\Resfenwrecks)
and open the User Manual. The User Manual will explain the next steps
you need to take to use the files. You will need Adobe Reader or other
program te open the PDF file.

It will copy the GPX_User_Manual.pdf and “Reef”.gpx file which contains the detail waypoints for the reef to the
folder you direct. We recommend a folder named C:\ReefsnWrecks\County\Reef but any folder will do. (Our
instructions will assume C:\Reefsnwrecks) Just be consistent and place all downloads into the appropriate folder. If you
have purchased contour charts in the past and are adding new ones, simply put the new ones in the existing folder.

Copyright © 2022 CSS Inc. 12



o » This PC » Windows (C:) » Reefsnwrecks * Broward » Lighthouse Reef

Ess

* [ Mame Date modified Type Size
= at3_user_rmanual.pdf 10772017 7103 AM Adobe Acrobat D... 1,814 KB
"j Lighthouse.gpx 9/25/2016 11:17 AM  GPX File T KB
LighthouseAT 5.zip 1012017 24 AM - Compressed (zipp... 5674 KB

GPX File Installation

You have purchased the GPX Format of the custom contour charts and you will need to download the file contents
into your GPS unit.

For example, Garmin uses a program called Homeport to read the GPX file and allow you to combine them with
other GPX files then load a file onto a SD card. You then take the SD card to your boat, insert the SD card and
select “Download Waypoints from SD card”. If you are using the GPX file with one of the contour maps, please
refer to that user manual for instructions on loading the GPX file into that program or App.

See appendix A for details on how to use Garmin Homeport.
Note: Be careful to back up or save your existing waypoints before loading new ones.

Please refer to your GPS User’'s manual on how to load a GPX file into your GPS. With so many manufactures and
models, it would be impossible for us to document every method used.

Sample Data

The Alan Fisher reef in Sarasota County is available for free and is useful to see and use the various formats that
are available. Download all the formats and try them out on your GPS unit, laptop computer, or tablet.

Waypoints

Each download also contains a .GPX file that has the waypoint that correspond to the callout on the maps. Load

the .GPX file into your GPS and you can navigate to those points shown on the printed maps. Refer to your GPS
user's manual to see how that is done. Typically by copying it to the GPX folder. Use the grid lines in the maps to
locate any other point on the map and enter those coordinates manually into your GPS.

If you view or edit a waypoint, information will come up describing the point. We have included a Name, and a brief
description of the site, year of deployment and the exact latitude and longitude.

» Garmin Oregon (G:) » Garmin » GPX »

v Burn MNew falder
P
Name Date modified Type Size
Archive 12/26/2015 8:49 A..  File folder
Current 6/19/2015 1:15 PM File folder
MNav 8/10/2015 2:16 PM File folder
4| Fisher.gpx 12/2/2015 2:27 PM GPX File 5 KB
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<7?xm1 version:"l.o encod1ng— ‘'utf-8" 7>
<gpx version="1.1" creator="0OpenCPN" xmlns:xsi="http: //www w3.0rg/2001/xXMLSchema-instance”
xmins="http://www. topograf1x com/GPX/1/1" xmins:gpxx="http://www.garmin. com/xm1schemas/prExtens1ons/v3"
Xsi: schemaLocat1on— ‘http: //www. topograf1x com/GPX/1/1 http://www.topografix.com/GPX/1/1/gpx.xsd"
xmlins: opencpn— ‘"http://www. opencpn. org">
<wpt lat="27.301666667" 1on="-82.619333333">
<time>1989-12-31T00:00:00Z</time>
<name>FISHR1</name>
<desc>Map #: 1; Deployed: 9/16/1980; Description: CONCRETE RUBBLE BOXES AND PILES; Depth: 31;
Relief:36.1</desc>
<sym>xmred</sym>
<type>WPT</type>
<extensions>
<opencpn:guid>01f90000-7f20-482a-af55-559c33820000</opencpn:guid>
<opencpn:viz>l</opencpn:viz>
<opencpn:viz_name>1l</opencpn:viz_name>
</extensions>
</wpt>

Example of a One Waypoint GPX File

Getting Started

We strongly urge you to read the User manual for your GPS Chart plotter and become familiar with all the other
features of your unit.

Getting Help
Any support questions or problems associated with your GPS Chart plotter should be directed to their support team.

Updates and New Charts

Thank you for your purchase. Check back to the web site often as we are adding new areas and natural ledges to
our inventory all the time. Remember, adding new charts are as simple as copying then to your Reefsnwrecks
folder and unzipping them to your SD card.

Any guestions about the Contour Maps should be directed to Bob@reefsnwrecks.com.

NOTE: We have set the price of Sarasota, Alan Fisher Reef to $0.08 so you
can download a full reef package in any or all the available formats and try
them out. Just follow all the instructions above to add it to your cart.

Sorry | have to charge 8¢ because PayPal cannot accept a $0 payment.
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Appendix A — Garmin Homeport

Appendix A — Garmin Homeport

Homeport is a PC based program from Garmin that allows you to see the exact same navigation charts as you will
see on your Garmin GPS. The program allows you to insert an SD card which has a copy of the charts that are in
your GPS unit and allows you to add waypoints and create routes. After they are created on the PC, you can save
them to your computer hard drive and load them into a SD card. The SD card is then brought to your boat, inserted
into the SD card slot of your GPS, select a few functions and it simply loads the file into your GPS. By using the
computer with a full keyboard, mouse and large screen sitting at a comfortable table makes entering data much

simpler.

To load GPX files into your GPS using Homeport follow the following steps:

1. To get HomePort, go to https://buy.garmin.com/en-US/US/prod64242.html

A
GARMIN PRODUCTS MAPS SUPPORT

v v

v

EXPLORE

v

Shop » Maps » On the Water Maps

GARMIN

2. Download the software and install it on your computer.

HomePort™
@ HomePort is available as a free download

Download for Windows
Download for Mac

G+l

More Images

3. Purchase a 4GB to 32GB SD card or a microSD card and adapter for use with your computer and GPS unit.

(microSD to SD and/or SD to USB)

4. In upper left corner highlight My Collection. Select FILE > NEW > LIST FOLDER. A folder with the name

New Folder will be created.

@ Garmin HomePort

| File | Edit View Find Tools Device Ltilities Charts Signln  Help
| Mew 3 | B List 1
Import into 'Reefsnwrecks'...  Ctrl+! |._:[ List Folder |
Export A Waypoint
] Backup... 0= Route
Restore... J  Route using Selected Waypoints
: &  Direct Route from Selected Track
= Print... Ctrl+P " Track
Exit &€ BirdsEye Imagery
L I=] =
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While highlighted, change the name to Reefsnwrecks.

then change name.

4 Library
[ My Collection

i b‘| Resfamwrecks

----- E Unlisted Data

If not highlighted, click twice slowly to highlight text

Next we want to create county lists under Reefsnwrecks. Highlight Reefsnwrecks and select FILE > NEW >
LIST. A New List will be created.

@ Garmin HomePort

File | Edit View Find Tools Device Utilities Charts Signin  Help
| Mew m@ List
Import into 'Sarasota'..  Ctrl+l L4 List Folder
Export A Waypoint
Backup... 28 Route
Restore... o#  Route using Selected Waypoints
_ _ '_',‘_ Direct Route from Selected Track
=4 Print.. Ctrl+P Bl Tack
Exit € BirdsEye Imagery

4 Library
E',l‘ My Collection

7. While highlighted, change the name to the County where the reefs are. For example “Sarasota”.
highlighted, select the list and click twice slowly to highlight text then change the name.

EIE] Resfsnwrecks

..... =| Sarasota

----- E Unlisted Data
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8. Now we want to import the GPX files that you downloaded from the Reefsnwrecks website. Go to the folder
which you saved the files and run the reef.exe file, if you have not already done so and extract the
<reef>.gpx file. Go to HomePort, Highlight the county, (e.g. Sarasota) and select File > Import into
<County>, browse to the <reef>.gpx file, select it and press Open. You should see the waypoint for the reef
listed in the lower left corner of the screen.

4 Library
[ My Collection
El E:.' Reefsmwrecks

E Sarasota

(.. [ Unlisted Data

Sarasota ¥

® FISHR1
* FISHRZ
* FISHR2
* FISHR4
* FISHRS
* FISHRE
* FISHR7
* FISHRE

9. Repeat this last step for all downloaded GPX files that are within this county.

4 Library
[ My Collection
ElE' Reefsnwrecks
E Sarasota

..... [ Unlisted Data

Sarasota ¥

* CNTROM
* CNTROZ
* CNTRO3
* CUDAHT
* CUDAHZ2
* CUDAH3
* CLDAH4
* FISHR1
* FISHRZ
* FISHR3
* FISHR4
* FISHRS
* FISHRE
* FISHRY
* FISHRE
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10. If you have downloaded multiple counties, create another List by selecting Reefsnwrecks and selecting File
> New > List. Name the new list as before. Import waypoints into that list like before.

4 Library

[ My Collection

EI Eirﬂeefsnwrecks
----- @ |H|IIsborough

ErLlnllsted Data

11. If you want to change the waypoint symbol, select the waypoints you want to change by selecting the first
waypoint then pressing and holding Shift then selecting the last waypoint. This will select the first, last and
all the waypoints in the middle. Right mouse click any waypoint selected and select Open. The Name field
should display ## waypoints selected. In the Display Mode box select the Pull down menu and select a
symbol. Select a unique symbol so you will know that these are exact, spot on waypoints as opposed to
unconfirmed waypoints.

Sarasota F

WP cnTrRot

@ cuTRe2
@ cuTRo3
W cubaH1
@ cubanz
@ cubaHs :
@ cupaHa @ 15 waypoints selected m]

@ FisHR1 Propetties | Notes

' FISHR2 Mame: |15 waypoints selected |

W FisHR2
i : Symbol and Name ~
’ FISHR4 Display Mode: ' || Symi

=L W AL —

@ FisHRs Postion: | 3 B W B i k8 B [ )

' FISHRE Elevation: Mark

o |+ N AP ANES O
e @M APANEMSO
Tewens: @M S QANEMP O
s @ P FOODABRE
Cty: | Covl
we FORFPEAEEH
resicore: (M1 B ¢ O @KW R W
oy | B R [A] & v

Phone Mumber: | |

00% LI LEN

Bl LEN
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12. Remove the SD card from your GPS and plug it into your computer. If your GPS uses a micro-SD card you
will need a micro to regular SD adapter (should have come with the micro-SD card). If you do not have a
built in SD slot in your computer, you will need to purchase a USB to SD card adapter. Once you have
inserted your SD card into the computer, HomePort should sense it and display it under Devices in the left
column.

[ My Collection ~
BET Reefsnwrecks

@ Manatee
@ Finellas
@ Sarasota

[P Unlisted Dats
4 Devices
[ GPSMAP 4208 (Unit ID 3279260088) (F:)

untitled

[ US Marine Detail g2i

GPSMAP 4208 (Unit ID 3279260088 (F:) L

13. To transfer the waypoints to the SD card select a list, e.g. Sarasota, and right click you mouse and select
Send To..., select your SD card under Devices and press OK.

=5y Coltection * || LatLon hddd®mm.
BE} Reefsnwrecks

=z
H H ~
@ Manatee =
@ Pinellas =
S
@ Sarasota g
[ Unlisted Datz

4 Devices
4 m GPSMAF 4208 (Unit ID 3273260052) (F:)

- [@) untitled

Bl US Marine Detail g2

a7

43

<
00F'L} LEN

Sarasota ¥

@ cuTrRot

@ cuTroz

' CNTRO3 4 Library

[ My Collection
@ cubsHi ;
E- E’ Resfsnwrecks

' CUDAHZ @ Manatee
@ cupamz - |Z] Finellas
@ CupsHs 4 Devices
GPSMAP 4208 (Unit ID 3279260008 (F:

@ FisHRT L aiho e F) |
' untitled

FISHR2
@ FisHR3
@ FisHR4
W FISHRS
W FisHRs

@ FisHR?
Cance
@ FisHRs "

= a.

@ Select Destination *

14. Leave the default selection of Create a new ADM file with name: <County> e.g. Sarasota.
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@ HomePort *

Specify an ADM file in GPSMAP 4208 (Unit 1D 3279260052) (F:) for your data:
() Choose an existing ADM file:

untitled w

(® Create a new ADM file with name:
|Sa|asc|ta |

£

15. Press OK. You will see a list created on your SD card and the waypoints transferred.

4 [evices
..l GPSMAFR 4208 (Unit 1D 22752600%8) (F)
B Sarasota

B uniitled

..... [ Us Marine Detail g2

16. Remove the SD card from the computer and insert it into your GPS unit. The card should be automatically
sensed and the Data manager screen should come up. Backup the waypoints in your GPS if you want to
save them and then follow the waypoint loading instructions from your user manual. e.g. a GPSMap had the
following instructions.

Viewing INFORMATION

Viewing User Data
To view user data from the Home screen. select Information = User Data.

Waypoints—view a list of all saved waypoints (page 23).
Routes—view a list of saved routes (page 27).
Tracks—uview a list of saved tracks.

Data Transfer—iransfer waypoints, routes, and fracks fo and from an SD card or network.

To transfer data to or from an SD card:
1. Insert an SD card into the SO card slot on the front of the unit.

2. From the Home screen, select Information > User Data > Data Transfer > Card.
Complete ane of the following:
= Select Save To Card to save waypoints, routes, and tracks to the SD card.

=« Select Merge From Card to fransfer data from the SO card to the unit and combine it with
existing user data.

» Select Replace From Card to overwrite items on your unit.

17. Select each list you want to load one at a time. To load the first list you might use Replace From Card that
will delete all waypoints and load the new set. To load the second to last list you should select Merge From
Card so the additional waypoint are added to the existing waypoints without deleting any.
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18. In addition, you can load our KMZ Custom Map format into Homeport and see our contour maps as you
would see them on your hand held GPS units. Unfortunately, Garmin has chosen not to support Custom
Maps on their line of Marine Depth sounders. However, by using Homeport, you can view our custom
contour map and set additional waypoint on points that you want to explore. Then transfer all the waypoints

to your Marine Depth sounder.
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